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About 3DPageflip Professional 

Want to make your PDF books published with real 

3D page turning effect to read on various digital 

devices? 3D PageFlip Professional will make your 

dream come true, which helps to convert your still 

PDF files into animated 3D page turning books, and 

more fantastic feature of the amazing software is 

that you can add multimedia music and videos on 

pages, even links, images, YouTube and flexible 

buttons, etc. Make the reading life of your 

audience more interesting and convenient now! 

 

 

 

 

 

 

 
 

Note: This product is distributed on a "Try 

before-you-buy" basis. All features described in this 

documentation are enabled. The registered version 

doesn't insert a watermark in your generated 

page-flipping eBooks. 
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Product features 

1. Convert single or batch PDF to page flipping 3D eBook with multi-media embedded. 

2. Define page range, convert render engine, page quality and size for imported PDF. 

3. Import PDF with links; import page text for search purpose; import table of content; Detect 

wide pages. 

4. Edit pages with adding 360 degree spinning products, 3D video, YouTube movies, audios, 

links, SWF, text button, bitmaps buttons and YouTube videos. 

5. Provide many different styles pre-designed templates, including 3D panoramic template. 

6. Download more free themes to use: http://www.3dpageflip.com/themes-2012.html . 

7. Export and save settings or projects for future use, record page info to save your 

multimedia designs. 

8. Enable Auto Flip with setting Flip Interval. 

9. Add background sound and play loops. 

10. Set page thickness and make book auto scale in different Flash containers. 

11. Input Presenter name, website address, Email and details info to show in About Window. 

12. Set Flash buttons display language, define eBook language by yourself. 

13. Set logo link and image, define color for Tool Bar. 

14. Pre-set tilt angle while opening the eBook. 

15. Set background with pure/gradient color or image directly. 

16. Show or hide any button as you want. 

17. Enable readers to sharing via Facebook, Twitter, iGoogle, etc, Sharing Analytics supported. 

18. SEO and Google Analytics Integrated. 

19. Output to different formats: HTML (publish online), ZIP (send via email), EXE (read 

separately). 

20. Make Mobile Version to work on iPhone, iPad and Android devices, output Epub format 

and burn to CD as you want. 

http://www.3dpageflip.com/themes-2012.html
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3D Digital eBook features 

While reading your created page-flipping 3D eBook, readers can do: 

1. Drag to turn page or click navigational buttons to turn pages. 

2. Drag 3D eBook to spin in 360 degree in 3D panoramic background. 

3. Double-click or click zoom in/out button to zoom in or zoom out pages in multi-level. 

4. Watch view in 3D vision; Open a pop-up object with 360 degree spinning effect. 

5. View your embedded flash, listen to your inserted music, view image slideshows, etc. 

6. Manually define Tilt Angle or wheel mouse to change angle to view eBook pages. 

7. View pages thumbnails to go to interested page quickly. 

8. Flip pages automatically. 

9. Turn page-turning sound on/off. 

10. View eBook detail information. 

11. Share eBook URL via Facebook, Twitter, Digg, etc. 

12. Add bookmark on pages as notes for later reading. 

13. Print out the whole eBook or a selected range of pages. 

14. View page-flipping eBook in full screen. 

15. Open in the Browser to a specific page by adding a page index to your URL. 

E.G.www.yourdomain.com/index.html?p=4. 
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Quick Start 

1. Start 3D Pageflip Professional via the desktop shortcut ; 

2. Click the "Import PDF" icon  to enter into Import PDF interface; 

 

3. Click icon to choose PDF file from your computer; 

 

4. Click icon to enter into main processing interface; 

 

5. Define settings and page layout for eBooks, such as Title, Language, Share and Background, 

click "Apply Change" icon  at last; 

6. Click "Convert to 3D Book" icon  to enter into Output interface; 

 

7. Choose Output Type from HTML, ZIP and EXE, here take  as example; 

 

8. Click to set Output Folder as "C:\3dpageflipbook", input File Name as 

"DemoBook"; 

 

9. At last, click icon to output created 3D page turning eBook. 

 

 

 
 



                                    3D PageFlip Professional Utility 
 

                                        User Document 

Copyright 2012 by 3DPageFlip.com 
- 5 - 

 

Details on using 3D Pageflip Professional 

 

There are three main designing parts in Design Setting panel for you to design page flipping 

3D book: Tool Bar Settings, Flash Display Settings, and Flash Control Settings.  

I. Home Panel 

 

 

In this part, there are a series of basic functions: "Import PDF", "Save Project", "Open 

Project", “Page Editor”, “Convert to 3D Book”, “Batch Convert”, “Help”, “Option”. 

1. Import PDF and Project Options 

(1). Import PDF 

Click "Import PDF" icon  to choose PDF file from your computer: 

A. You can define page range to import and convert; 

B. Click "Application" button  to choose render engine for importing your PDF 

file. There are 3 different kinds of render engine for choose to avoid distortion for some 

special PDF files (Change option when PDF imported failed): 
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SWF: Much legible characters, smaller output size 

Inner Library: Faster convert speed 

C. Set Page Quality and Size to convert your PDF file: 

 

 

D. Import links and text content from your PDF file to click or search in 3D book later. 

 

(2). Import PDF links, text, and table of content 

Import Link: Make PDF links available in output 3D eBook. 

Import Search: Make PDF text searchable in 3D eBook. 

Import Table of Content: import the exited table of content. 

Detect Wide Pages: to help cut double-page into two pages for wide-page PDF. 

 
 

(3). Project 

Click "Save Project As…" in Files to save the imported files and current settings as a project 

file, and when you want to modify or complete the project, just click "Open Project" to edit 

the stored project directly. While editing, it’s OK to use short cut key “Ctrol + S” to quickly 

save your project. Otherwise, you can open the output eBook file (HTML format) directly via 

“Open the project from output folder”. 
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(4). Page Info 

Click “File > Export Page Info” to save your multi-media editing. If you want to modify PDF 

after adding lots of links, flash, video, you can save page info and use it after re-import the 

PDF. 

 

 

2. Edit Pages 

Click "Page Editor"  to add multi-media objects on pages: 

(1). Add Link 

Click the icon  and then draw a link box on the area you want to add link, then define 

properties in below panel: 

 

 

You can define the link action as "Go to page", or open an online webpage, or even "Call 

Javascript function" to carry out your wanted interactive functionalities via defining 

Javascript function yourself. For example, you can show a pop-up light box while readers 

clicking some image on page or pop-up a questionnaire or other Web Form by clicking some 
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text. Just make sure the parameter you set in "Function" can be called in from HTML page. 

 

Example: Check "Call Javascript function" as action type, then input Function as 

"testLightBox("Hello, this is a test"): 

 

And then make sure the Javascript wrote into the index.html page as below image shows 

(the same as you set in "Link Function"): 

 

 

(2). Add Movie 

Click icon  and draw an object on the page and insert FLV or MP4 movie: 
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Then you can select and edit the movie in below panel (define view in 3D Space or not, play 

and stop movie actions, etc.): 

 

If you choose to view in 3D space, you can get the 3D video effect like this: 
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(3). Add Image 

Click the icon  to draw image box and then select image (.jpeg, .jpg, .png, .gif), set 

Action Options (the same as Link Action Options): 

 

 

(4). Add Sound 

Click the icon  to draw sound box and then select sound file, set other options: 

 
 

(5). Add Flash 

Click icon  to insert SWF flash into your defined area of 3D ebook page: 
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(6). Add Button 

Click icon  to draw an area for inserting your text button file with add text on button, 

and calling actions. The actions contain "Go to page", "Open web page", "Call Javascript", 

"Play audio", "Photo slideshow" and "Show Video/SWF/Text": 

 
 

(7). Add Bitmap Button 

Click the icon  and draw an object in the right position of targeted page. You need to 

prepare two to three button images to create bitmap button. You can click “Normal image”, 

“Mouse over image”, “Mouse down image” to set button layout. 
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(8). Add You Tube Video 

Click the icon  and then draw a box on the page to insert You Tube video into pages 

directly. You just need to define the video ID directly. For example the video link is: 

http://www.youtube.com/watch?v=xKA6WIqjB7c, then the video ID is " xKA6WIqjB7c".  

 

(9). Create 360 degree product present (New) 

 

Click “Add Link” , Add Image , Add Button  or Add bitmap button  to 

create an object in flip page. Then set actions for these objects. One of the actions is 360 

Degree Product Present. It can help you create 3D animation with 360 degree spinning. 

Before creation, you need to prepare a group of images for your products with 360 degree.  
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View detailed steps in How to create 3D object with 360 degree view in page flip book? 

 

Besides, undo, redo, delete, cut, paste and copy. 

 

If you want to add same links, images, videos, audios to different pages, you don't have to 

repeat the "Link/Image/Video/Audio added" operations once and once again, just select the 

link object, click the "Edit->Copy" ( Ctrl+C ) and then go to the other page to click the 

"Edit->Paste" ( Ctrl+V ) directly. 

View more details about how to use short cut key: FAQ. 

 

After editing, click icon  to save objects and go to design window. 

3. Publishing Part 

Click "Convert to 3D Book"  to enter into output window as below 

image shows: 

Do as the following steps: Click “Set Action” > 

Tick “360 Degree Product Present” > Click “Add 

images” to import your original images > Click 

“Preview” and make further setting like speed, 

direction ect. 

http://3dpageflip.com/faq/how-to-create-3d-object-with-360-degree-view.html
http://3dpageflip.com/faq/how-to-use-shortcut-key-to-quickly-design-and-use-3d-ebook.html
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 (1). HTML 

 

 
 

This output type is for uploading created page-flipping ebook onto websites. You can define 

HTML Title and other properties by clicking "Advanced" button:  

 

 

 

Set Keywords and Description in the below interface: 

 

You can also check option "Also Make Mobile", after uploading all files online (including 
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HTML, SWF, "files" and "mobile" folders), then you can visit the flipbook page through 

browser on iPad, iPhone and Android devices. 

Or check "Also Make Epub" option to output Epub format book with HTML type together 

(EPUB became an official Professional of the International Digital Publishing Forum in 

September 2007, comparison of e-book readers contain: Android devices iPad, iPhone, and 

iPod Touch, Sony Reader).  

 

Or even "Burn to CD" to save or distribute the book: 

 

 

 

(2). ZIP  

 

 
 

This output type is for compressing the created files into an integral ZIP package which can 

be sending out as attachment directly. You can also define HTML Advanced Settings by 

clicking "Advanced" icon. Your recipients just need to uncompress the ZIP file and then they 

can view the HTML DemoBook instantly. You can also build Mobile version, Epub format 

book or burn to CD as you want. 

 

(3). EXE 

 

 
 

This type is for outputting 3D flipbook as a single executive file, easy storing and easy 
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viewing, you can also define Icon and Opening Window Size in Advanced Settings: 

 

 

 

You can also burn the EXE eBook to CD. 

 

After you complete all design and page edit work, click "Convert" to output your 

completed 3D book in selected format. 

 

4. Batch Convert 
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1. Add PDF files 

You can click "Add PDF" or "Add Folder" button to select PDF files from your computer. 

 

2. Settings 

(1). Output Type 

There are four output type in Batch Convert interface for you to use, HTML, ZIP, EXE and "Also 

Make Mobile" option. More details you can view "Publish Part" in Home Panel. 

 

 

(2). Path 

Define Output Folder and File Name for the output 3D books, you can use PDF FileName, Title, 

Author or Subject as book name directly. 

 

(3). Options 

You can also set HTML Title, and click "Advanced" button to define HTML metadata, like 

Keywords, Description, Script, etc. Check "Merger All PDF Files" option to combine all PDF files 

into a single 3D book. 

 

(4). Merge PDFs 

Tick to merge all PDF files into one, and you will get one 3D eBook totally. 

 

5. Help Part 

 

Click "About" to know the program version information and your register 

information, click "Help" to read manual of the program. 
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6. Option Part 

 

(1). Flash Information 

 

 

Click "Flash Information" option and you will be able to define information about 

eBook such as Author, Web Site and E-mail which will be shown in "About" window: 

 

Click "About" button  the below window will pop up instantly: 
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(2). Flash Language 

 
If you want to use another display language for your 3D flipbook, you can click "Flash 

Language" to enter into the Language Settings interface as below shows: 
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As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books 

in defined language, and the program provides you two different languages for you to use: 

English and Chinese.  You can also add other language for your own uses: 

 

1. Click the button  and define name for the new language: 

 

Click "OK" to save the new language in the list; 

 

2. Choose the first label and click "Edit" button , define new language text in 

"Labeled" box, then click "Save And Edit Next" (Alt+S): 

 

3. At last, you can get all Labels translated into your new language. 

You can delete unwanted language:  

Or save your edited new language file as XML or TXT file:  

Load language file saving before for current using:  
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(3). Flash Information 

 
 

Here you can set password to 3D Book in order to protect your digital publication. 

After that, when someone open the book, he will be asked to enter the password. If 

not, he can’t view the eBook. 

 

Firstly, Click “Flash Security”  in “Option” to enter setting interface.  

Then choose “Single Password” and type in your password. 

 

 
 

 

There is a personalized option: Exclude Front Pages. 

Set a page number, all latter pages can’t be viewed without inputting password. 
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II. Design Setting Panel 

 

 

In this part, you can design your 3D book layout with stunning own style. There are templates for 

selecting and three main setting parts for decorating: “Tool Bat Settings”, “Flash Display Settings”, 

“Flash Control Settings”. 

1. Template Part 

Click "Theme" icon  to select templates from below interface, 

there are three types, including Float, Handy and 3D Panoramic: 
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If you select the Panoramic template, you will gain cool 3D background scene. In the 

right top corner, there is a control panel, you can drag the little book in the panel to 

spin eBook in 360 degree. Double click the little book to go back to default state. If 

the light is red, you can’t turn page. If it’s green, you can turn page.  

 

After selecting a pre-define template, you can do a lot of settings in Page Layout 

panel which will be introduced later, and then you can click "Export Theme" to save  

our settings for later uses by clicking button "Import Theme" directly. Download 

more free themes to use: http://www.3dpageflip.com/themes-2012.html . 

 

2. Tool Bar Settings 

(1). Tool Bar Color and eBook Title 

 

You can define the "Base Color" for the tool bar and other windows. 

Define the title for your 3D eBook which will be shown on the top of the "About" 

window. 

 

light 

http://www.3dpageflip.com/themes-2012.html
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(2). Logo Settings 

 

Check "Show Logo" option to display your logo on the left side of the tool bar (165*35 is the 

recommended size of your logo image), you can also add link on the logo to let readers to 

click on the logo and go to your website directly. 

 

 (3). Auto Flip 

 

To auto flip your eBooks, you can set "Enable->Yes", then define loops and Flip Interval (seconds 

of staying on each page). After clicking the Auto Flip button, the flipbooks will be flipped by 

staying 3 seconds per page. 

 

(4). Background Sound 

 

If you want to add background sound to your flipbook, such as a song or other audio file, click 

"Sound File" to choose audio from your computer, then set "Loops->Yes". The "Play Flip Sound" 

option is to help you define whether play page flipping sound or not when flip pages. 

 

(5). Visible Buttons 

Go to "Visible Buttons" option to define show or hide icons on the toolbar, including Zoom, 

AutoPlay, Info, Thumbnail, Print, Help, Tilt Angle, Background Sound, Bookmark, Share and 

FullScreen. 

 



                                    3D PageFlip Professional Utility 
 

                                        User Document 

Copyright 2012 by 3DPageFlip.com 
- 25 - 

 

 

3. Flash Display Settings 

(1). Background Config 

 

If you don’t want to use the background in pre-set templates, you can design your own 

background. Set "Background Type" as "Image", "Pure Color" or "Gradient Color".  

 

 

a. Image Background 

Choose Image Style background, then choose "Picture" from computer, and define 

"Position". 

 

 

b. Pure Color Background 

You can make your 3D book background simple with setting a "Pure Color": 

 

 

c. Gradient Color 
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(2). Page Thickness and Auto Scale 

 

You can show your book in original page size with un-checking the option "Auto Scale", or let the 

book show properly in different Flash Container with checking this option. The program helps to 

build page-flipping eBooks with real life-like book effect, you can set thickness per page. 

 

You can define default tilt angle for your created digital book, the value you can set to is number 

between -20 and 20. The readers can change tilt angle manually too by clicking the "Tilt Angle" 

option or just wheel the mouse directly.  

 

Click "Apply Change" icon to apply the settings. 

 

III. Flash Control Settings Panel 

 
In the HTML output format, you can add statistics by using google analytics. You can get more 

information about Google Analytics ID from http://www.google.com/analytics/. And 3DPageFlip 

program uses AddThis sharing platform which supports hundreds of sharing channels. Just build 

your own user account and get account ID. Then after you publishing your create 3D eBook 

online, you can know how many people shared your eBook in your account record. More details 

please view info in the FAQ page as reference: 

http://www.3dpageflip.com/faq/9.How-to-enable-readers-to-share-published-3D-eBook-online-

with-analyzing-embedded.html . 

 

 

 

 

 

 

http://www.3dpageflip.com/faq/9.How-to-enable-readers-to-share-published-3D-eBook-online-with-analyzing-embedded.html
http://www.3dpageflip.com/faq/9.How-to-enable-readers-to-share-published-3D-eBook-online-with-analyzing-embedded.html
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License Agreements   

All copyrights to 3DPageflip Professional (the Software) are exclusively owned by 

3DPageFlip.com. For more information, visit our website at www.3dpageflip.com . 

 

Anyone may use this software but all the page-flipping eBooks generated will automatically 

have a demo watermark on the first page of them. To remove the limitation you must 

register. 

 

Once registered, the user is granted a non-exclusive license to use the Software on one 

computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased, 

but may be permanently transferred, if the person receiving it agrees to terms of this 

license.  

 

The Software unregistered (trial) version may be freely distributed, provided the distribution 

package is not modified. No person or company may charge a fee for the distribution of the 

Software without written permission from the copyright holder.  

 

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR 

IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS, 

DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS 

SOFTWARE. 

 

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble, 

otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed 

Software, except as provided for in this agreement. Any such unauthorized use shall result in 

immediate and automatic termination of this license and may result in criminal and/or civil 

prosecution. 

 

All rights not expressly granted here are reserved by 3D PageFlip. 

 

Installing and using the Software signifies acceptance of these terms and conditions of the 

license. 

 

If you do not agree with the terms of this license you must remove the Software files from 

your storage devices and cease to use the product. 

 

http://www.3dpageflip.com/
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How to Order 

Order Online (http://www.3dpageflip.com) or Order Toll Free 1-877-353-7297 (When you 

order toll free just give the operator the product number of the product you would like). 

 

How to purchase online?  

 

1. Select a license type above, and click [Buy Now] 

 

2. Select the currency that you want to use. (You can also continue shopping) 

 

3. Fill billing information and select a payment method. (Your information is safe with us) 

 

4. Check the information you filled previously and click "Place Secure Order"  

 

Other Order Ways—With Phone/Mail/Fax/Check: 

 

If you are not comfortable ordering online with a credit card, you are welcome to choose an 

offline order option in the payment section of the order process. We accept mail, fax, wire, 

and PO (if applicable) ordering options in addition to ordering online. We also provide 

phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for 

International Callers.  

 

Please note that all of the offline ordering options do have additional fees for processing. To 

place an order by mail, fax, wire, and PO (when applicable), use the online form and then 

choose one of these payment options found in the Payment Method section of the form. 

Once submitted online, the appropriate information will be provided to you in your web 

browser to send your payment to us offline. 

 

100% unconditional 30 Day Money Back Guarantee 

 

 

Want to custom the program or have other questions about purchase? 

Contact us at support@3dpageflip.com . 

 

 

mailto:support@3dpageflip.com
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Support 

You can easily search or browse our frequently asked questions, learn tutorials about 

products, and get your registration code back. If you don't get a satisfied solution via above 

ways, please don’t hesitate to contact support team for help. 

 

1. Frequently Asked Questions 

You can find answers to questions about technique issues here: 

http://www.3dpageflip.com/faq.html 

 

2. Get lost license code 

Click here to look up the order » (http://www.regnow.com/cs/orderStatus) 

You can pull up a copy of your order by entering your email address. After you find your 

order, you may view its status, view details of your order (including the license key), and 

obtain the invoice.  

 

3. Contact Us  

If you have other questions or requirements, contact us directly through our support Email: 

support@3dpageflip.com, we will respond you ASAP. 

 

 

 

 

 

 

 

 

 

 

http://www.regnow.com/cs/orderStatus
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http://www.3dpageflip.com 

http://www.3dpageflip.com/

